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About This Manual 

This manual provides information about configuring the IBM FileNet Image 
Services Resource Adapter (ISRA) version 3.4.0.x on SAP WAS 6.40 platform. 
Refer the separate ISRA Installation Guide for Installing ISRA 3.4.0.x. 

Conventions Used in the Document 
The table lists the formatting conventions used in this document. 

Conventions Description 

Fixed Size font Used for commands entered at the system command 
prompt. 

Arial font Used for important notes 

Bold Occasionally used to refer to portions of user interface, 
such as the Next button or the Install button 

Related References 
For all ImageViewer parameters please refer to the FNImageViewer 
documentation provided with ISRA installation media. 

<ISRA-home>\ISRA340\FNImageViewer\docs 

For all P8 System Manager related information, please refer to P8 System 
Manager documentation, provided with ISRA installation media. 

<ISRA-home>\ISRA340\SystemManager\docs 

Comments and Suggestions 
IBM FileNet invites all customers to communicate with the Documentation group 
on any question or comment related to IBM FileNet manuals and online help. 
Send email to comments@us.ibm.com. We will make every effort to respond 
within one week. Your suggestions help us improve the products we deliver. 

 

mailto:comments@us.ibm.com
mailto:comments@us.ibm.com


 

1  
ISRA Deployment 

This chapter describes the deployment of ISRA on SAP WAS 6.40 platform. 

Note The installation procedure for SAP WAS 6.40 is outside the scope of this 
document. This guide assumes that the required settings and 
configurations have already been made. 

Deployment Requirements 
This section lists the minimum software and hardware requirements for 
successful deployment of ISRA on SAP WAS 6.40 Application Server. 

Caution All the xml related to the deployment of ISRA must be created 
manually or use a pre-existing file that is valid. Do not copy xml 
contents straight from the Deployment Guide. 

Hardware Requirements 

• For additional information on SAP WAS 6.40,visit 
http://www.sap.com/netweaver 

• ISRA installation will require approximately 120 MB free disk space. 

Software Requirements 

• SAP WAS 6.40 installed on Microsoft Windows 2003 Server 
• IBM FileNet IS 3.6 SP2 and above 

Mandatory Requirements for ISRA 
The mandatory requirements for ISRA 3.4.0 is:  

• Include the folder in which WinPerfMon.dll is present in the system path 
in case of Windows operating system. In LINUX, this file is not required. 

• Enter the initial and maximum JVM heap size as 512. 

Deploying ISRA 
To deploy ISRA on SAP WAS 6.40: 

1. Navigate to the directory where ISRA 3.4.0 is installed. Select the 
ISRA.rar file from the Jar folder of ISRA installation directory and copy 
the file under a temporary folder. 
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2. Run jar -xvf ISRA.rar command from temporary folder location. 

 
3. Delete ISRA.rar file from temporary folder. 
4. Add listener.jar and log4j-1.2.8.jar to the temporary folder. (The 

System Manager folder contains the listener.jar and log4j-1.2.8.jar) 
The following screen appears. 
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5. Create a file named connector-j2ee-engine.xml to specify the JNDI 
name with the following content: 

<?xml version='1.0' encoding='UTF-8'?> 

<!DOCTYPE connector-j2ee-engine SYSTEM 'connector-j2ee-
engine.dtd'> 

<connector-j2ee-engine> 

<jndi-name>ISCF</jndi-name> 

<pool-params> 

<max-connections-number>10</max-connections-number> 

<max-time-to-wait-connection>60</max-time-to-
wait-connection> 

<expiration-control> 

<connection-lifetime>60</connection-lifetime> 

</expiration-control> 

</pool-params> 

<connector-group> 

</connector-group> 

</connector-j2ee-engine> 
6. Include the connector-j2ee-engine.xml file under the /META-INF 

folder extracted from ISRA.rar. The following screen displays the 
connector-j2ee-engine.xml file included in /META-INF folder. 
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7. In the command prompt, navigate to temporary folder where ISRA.rar 

is extracted. Create ISRA.rar using the JAVA command: 
jar -cvf ISRA.rar *.*. The following screen appears: 

8. Run the DeployTool.bat file from the following location \\usr\<sap 
was instance>\J2E\JC00\j2ee\deploying to start the deploying tool 
of SAP WAS 6.40. The following screen appears: 
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9. Click Project > New Project to create a new deployment project. 

 
10.  The following screen appears: 
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11. Select the directory location from the Directories frame and specify 
the project name in the Address text box. Then click OK. The following 
screen appears. 

 
12. Click the Assembler tab. Right-click on project name (here it is 

isra_34sap). The following screen appears: 

 
13. Click the ADD Archives icon. Following screen appears. 
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14. Select the directory location of the installed ISRA.rar from the 

Directories frame and click OK. The ISRA.rar is included in the current 
project. 
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15. Right-click on project name (isra_34_sap) to open the context menu, 
and navigate to Make Ear.  

 
16. The following screen appears. 

 
17. Specify the directory location of the ear file from the Directories frame 

and enter the name of the ear file in the Address textbox. Click OK. 
The following screen appears: 
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18. Click the Deployer tab. Click the Connect icon to open the SAP login 

dialog box. The following screen appears. 

 
19. Enter the Password, and click Connect.  
20. Click on the ISRA.rar link under isra_34_sap project. Select Deployer 

> Server Settings > Additional Settings tab to specify the JNDI 
name. 
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21. Right-click isra_34_sap project to open the context menu. From the 

context menu click Deployment > Deploy EAR. 

 
22. The server may take some time to complete the deployment process. 

The deployment status will be displayed as shown in the following 
screen: 
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23. Click Yes to start the deployed application. The following screen 

appears with a message in the status bar “Application Started 
Successfully”. 

 
24. Deploying ISRA is completed.  
25. Next step is to complete the Mandatory steps necessary for ISRA. Refer to 

Mandatory Requirements for ISRA section before restarting the Application 
Server. 

 
Explanation for Terminal name and ISRALock folder 

The first instance of ISRA deployed on an Application Server creates a folder 
named "ISRALock" and a file named1 "ISRALock.0" inside that folder. The 
counter "0" in the file name "ISRALock.0" increments subsequently with each 
new deployment of ISRA and the same is appended to the terminal name 
generated for an ISRA instance. This folder is created in the path resolved by the 
system property "user.dir", which is the same path where the ISRA logs are 
generated. This functionality has been introduced in ISRA 3.2.1 to support 
vertical cluster environment.  

                                                      
1 ISRALock.0 (0-9 and a-z) would be created in ISRA 3.4 FP3 and above. Prior versions of ISRA would 
have files created as ISRALock.0000 (0000-9999). 



 

Terminal name identifies ISRA instance with a unique id so that IS can 
distinguish each ISRA client uniquely for communication. Earlier, the terminal 
name used to be of the form "SV<instance number>.<Counter1>@IPAddress". In 
case of a vertical cluster, ISRA can be deployed across the cluster on a single 
machine. But in such a scenario, all the managed server instances in a cluster 
will have the same ISRA instance deployed and will generate the same terminal 
name, as the "IPAddress" and "instance number" will be same for all the ISRA 
instances. The current format of a terminal name generated by ISRA is 
"R<instance number><Counter1><Counter2>@IPAddress", where Counter2 is 
the counter appended to the files created in the ISRALock folder as mentioned 
above. The files created in the ISRALock folder will be automatically removed if 
the managed servers are gracefully shut down (in case of proper JVM 
shutdown).  

See Configurable ra.xml Properties section below for “DeploymentInstance” 
property setting. 
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2  
ISRA Configuration 

This chapter describes the ISRA configuration, deployed on SAP WAS 6.40 
Application Server. 

Configuring Deployed ISRA 
This section describes how to edit the ISRA deployment descriptor after 
deployment. 

ISRA uses the J2EE Connector Architecture deployment descriptor, called 
ra.xml to define its operational parameters. The deployment descriptor is defined 
by Sun Microsystems in the J2EE Connector Architecture 1.0 specification. It 
describes the Resource Adapter related attributes, types, and deployment 
properties using a standard Document Type Definition (DTD). 

To edit the ISRA deployment descriptor, perform the following steps: 

1. Run the go.bat file from the following location \\usr\<sap was 
instance>\J2E\JC00\j2ee\admin to start the Visual Administrator of 
SAP WAS 6.40. The following screen appears. 

 
2. Click Connect. The following screen appears. 
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3. Enter the Password, and click Connect. The following screen 

appears. 

 
4. Navigate to J2E > Server 0 <id> > Services. Expand Services and 

click Connector Container. The following screen appears. 
 

Note The id of Server 0 depends on the patch level version of J2EE Engine 
used in SAP NetWeaver WAS 6.40.  
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5. Under Connector container, navigate to Connectors > Connector 

1.0 > sap.com/isra_34_sap > ISCF. The following screen appears. 

 
6. Under the Managed Connection Factory tab, open the Properties 

tab. All the configurable properties are listed here. 
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The user can make changes to the parameters as required. For details, refer to 
Changing ISRA Specific Parameters section. 

Changing ISRA Specific Parameters 
After ISRA is deployed, some parameters of the Deployment Descriptor need to 
be changed to configure it for the target IS server. 

To change the ISRA specific parameters, perform the following steps: 

7. In the SAP NetWeaver Visual Administrator, navigate to the 
Properties tab, as shown in the above figure, under Managed 
Connection Factory tab in ISCF. Refer to Configuring Deployed ISRA 
section for details. The following screen appears. 

 
8. Select the Key name under Configuration Properties section. For 

example: DomainName. The details of the key are reflected below 
the table. Change the values in the fields: Key, Value, Type, and 
Description, and click Add button (For Example, here 
DomainName property is changed from israis to isserver). The 
following screen appears. 
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9. After changing the value against the required property, click Save 

Changes icon. The following confirmation message appears. 

 
10. Click OK. 

Configurable ra.xml Properties  

The configurable properties to be set (modified) in ra.xml are: 

• DomainName 
• OrganizationName 
• LoggingLevel 
• LoggingMode 
• PageBufferSize 
• CacheRefreshInterval 
• SecurityCacheMode 
• MetaDataCacheRefreshMode 
• LogFileName 
• LogFileSize 
• LdapImplClassName 
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• LdapImplClassString 
• InherentLogin 
• DeploymentInstance 
• PCHLogging 
• AllowAnonymousUser 
• RPCLogging 
• ClientCodepage 
• GMTEnabled flag 
• ISLocale 
• IgnoreObjectBusyMsgInDocMigration 
 

Note Please note that all properties described in the deployment descriptor 
are mandatory and no property should be removed. Default values 
should be specified for properties that users do not want to use. 

DomainName 

This is the domain name of the IS server. The default value of DomainName is 
FileNetIS. It should be set according to the operational environment. Change this 
property to the domain name of the IS. 

 

OrganizationName 

This is the FileNet IS organization name. The default value of OrganizationName 
is IBM. It should be changed according to the operational environment. 
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LoggingLevel 

This is an integer representing the amount of log information to be generated. 
The values are dynamically updatable by using the ISRA Console. The valid 
values are: 

Logging Level Description 

-1 Disables ISRA Logging 

0 Only Error and Warning messages will be logged by ISRA 

1 Informative messages will also be logged by ISRA 

2 Prints debug message in the log 

The default value of LoggingLevel is 0. It can be modified to other valid Logging 
Levels. It is recommended to keep the logging level at 0. LoggingLevel can be 
increased if user encounters a problem while accessing ISRA through the 
application. 
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LoggingMode 

This is an integer representing the logging mode. The valid values are: 

Logging Mode Description 

0 No Logging 

1 Only console logging 

2 Only file logging 

3 Both console logging and file logging 

The default Value of LoggingMode is 3. It can be changed to other valid values 
according to the operational environment. 
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PageBufferSize 

This is an integer value specified in kilobytes (KB). PageBufferSize specifies the 
chunk size used by ISRA to transfer page data to and from IS. The default value 
is 64 KB. Specifying a higher value will require more memory for the Application 
Server process, and a low PageBufferSize will mean more trips to IS. The value 
should be set to an average page size on the target IS. The document buffer size 
on IS and ISRA should match to optimize image transfer performance. 
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CacheRefreshInterval 

This is an integer value specified in minutes. ISRA stores meta-data information 
like Document class, Indices, menu details etc. in a local cache for faster 
retrieval. ISRA refreshes the cache information based on the 
CacheRefreshInterval value. The default value is 30 minutes. 

 

SecurityCacheMode  

This parameter can take two values:  

Value       Setting 

1 Caches both users and Groups 
2 Caches only groups 

MetaDataCacheRefreshMode 

This parameter can have a value in the range of (0-15).  

Value       Setting 

0 No Metadata cache refresh 

1 Printer cache refresh only 

2 Document class cache refresh only 

4 Key Fields cache refresh only 

8 Menu Value cache refresh only 

15  is the default value for this parameter, which will refresh all 
metadata. 

Add corresponding values to get a combination of data. 
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For example,  1+2 = 3 Printer and Document class data 

               1+2+4 = 7 Printer, Document class, Key Fields data 

0+1+2+4+8 = 15 all data 

LogFileName 

The LogFileName is a string containing the name and path of the log file. The 
default value of LogFileName is ISRA.log. A complete or relative path can be 
provided to create the log file at a specific location on the disk. 

To ensure that each ISRA instance has a unique log file, the following steps will 
be followed: 

• Configurable property “DeploymentInstance” will be read from ra.xml and 
appended to the log file name. If not specified, the default value “1” will be 
used as the deployment instance of ISRA. 

• The unique ID used for terminal ID generation in ISRA will be appended to 
the log file name. 

For instance, if the log file name configured in ra.xml is ISRA.log and the 
deployment instance is 1, the modified log file name would be ISRA_1_0.log. 
Here, “0-9 and a-z” is the unique ID2 generated at run time. This ensures a 
unique name of the log file for each instance of ISRA. 

 

LogFileSize 

This is an integer representing the maximum size of the log file in Megabytes 
(MB). When the size of the file reaches this maximum limit, the log file is 

                                                      
2 The modified log file name would be ISRA_1_<unique-ID>.log. The value for unique ID is 0-9, a-z in 
ISRA 3.4 FP3 and above. Older versions of ISRA use the unique ID value between 0000-9999. 



 

renamed and a new file is created with the same name. For example, 
ISRA_1_0.log is renamed to ISRA_1_0_1.log, and a new file ISRA_1_0.log is 
created. The default value of LogFileSize is 5MB. Automatic purging of old ISRA 
log files has been implemented leaving behind only 5 latest versions. 

 

LdapImplClassName 

It is the name of the Implementation class for LDAP Authentication. This 
parameter contains the complete path of the LDAP Implementation class to be 
entered along with the LDAP Implementation Class Name. 

The default value is ‘com.filenet.is.ra.fnis.FN_IS_IPlanetImpl’. 

The value of the property for LDAP implementation for Active directory is 
com.filenet.is.ra.fnis.FN_IS_ActiveDirImpl and for Novell NDS is 
com.filenet.is.ra.fnis.FN_IS_NovellNDSImpl. 
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LdapImplClassString 

This parameter is a general string that takes in all the LDAP Server specific 
parameters required for authentication. It takes the following inputs: 

• Server Name – Name of the Server/ Machine on which LDAP Server exists. 

Note In case that the LDAP server is located on a different subnet, it may be 
necessary to enter IP address or a full domain name. 

• Port Number – LDAP Server’s port number used for transactions. 
• User Path – Organization unit under which the users are filed in the LDAP 

Directory Server. 

The three parameters must be separated by semicolon and must appear in the 
order - server name, port number and user path. An example of 
LDAPImplClassString is: 

• For Active Directory 

filenetserver;389;ADS.com 

• For IPlanet 

filenetserver;389;uid= user1, ou=ISRA, dc=odc, dc=filenet, dc=com 

• For Novell NDS 

filenetserver;389;cn=user1, ou= ISRA, o=FileNet 
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InherentLogin 

To use LDAP security, the value will be set to 1 from the default value 0. 
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DeploymentInstance 

This is the instance number of ISRA that is being deployed. It is a user defined 
number between 1 and 100. The default value for this parameter is 1 when none 
is specified. The maximum is 100, which means that 100 different instances of 
ISRA can be deployed on a single machine. 

Each deployment/JNDI of ISRA on the same Web/Application server requires its 
own instance number. For example, there can be 2 ISRA applications deployed 
on the same Web/Application server. Each deployment would require its own 
instance number and JNDI name. This number is used on the IS server to 
differentiate between multiple connections from the same IP address of the 
Web/Application server. 

IS always expects unique IDs from ISRA clients, and when it receives duplicate 
IDs from ISRA, it will reject communication. 

So it is always advised to increment the deployment instance number when 
another instance of ISRA is deployed to achieve its unique id. 

Format of the terminal ID is used by ISRA and IS in distinguishing a Unique ISRA 
instance.  

RXXYYYZ@<ip-address>  

Where,  

XX = takes values from 1 to 100. If there is only one instance then it 
defaults to 1. Else the value has to be set to the Number of Deployment 
instances.  

YYY = Counter that increments with the creation of a new LogonSession 
object (Values in base 36) 

Z = Unique ID generated per ISRA instance. Introduced to support ISRA 
in clustered environment (Unique ID is a number in Base 36) 

<ip-address> = IP Address of the machine where ISRA is deployed. 

The Unique ID is obtained from the place holder file ISRALock.z (where 
Z=Unique ID) that is created in the ISRALock folder. Each cluster 
member creates its own place holder file (like ISRALock.0, ISRALock.1 
and so on) within the common ISRALock folder. 
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PCHLogging 

This is a String parameter to enable/disable PCH logging in ISRA. The default 
value for this parameter is “Disabled”. PCHLogging enables user to log 
performance monitoring data of IS. 
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AllowAnonymousUser 

It’s a Boolean value to allow Anonymous user logon through LDAP, when blank 
password is passed from user/client. The default value of this parameter is 
“false”. 

 

RPCLogging 

This is an integer representing the RPC logging level. The valid values are: 

RPCLogging Description 

0 No Logging 

1 File Logging 

 The default Value of RPCLogging is 0. It can be changed to 1 if RPCLogging is 
required.  

The RPC LogFileSize is taken as double the size of that of ISRA LogFileSize. 
So, when the size of the RPC log file reaches its maximum limit (10mb), the log 
file is renamed, and a new file is created with the same name. For example, 
ISRA_1_0_RPC.log is renamed to ISRA_1_0_RPC_1.log, and a new file 
ISRA_1_0_RPC.log is created. Automatic purging of old ISRA RPC log files 
has been implemented leaving behind only 5 latest versions. 
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ClientCodepage 

This is the code page for encoding Text and Sticky Note annotations. The default 
value for this parameter is Cp1252. 
On Microsoft Windows platform, the Locale character set is the Windows Code 
Page (1252 for US English and Western Europe) whereas on a UNIX platform, it 
is an ISO 8859-X character set (ISO 8859-1 for US English and Western 
Europe). 

Thus, if the client locale character set, is Windows Code Page based (for 
example: Cp1252 for US English and Western Europe), and the server is UNIX 
based, then Windows Code Page should be used for encoding the annotations 
data before committing to the server. This is because; there is an inconsistency 
in characters mapping between Microsoft Windows Code Pages and the 
equivalent ISO 8859-X series. For instance, Code page 1252 is built on ISO 
8859-1 but uses the range 0x80-0x9F for extra printable characters rather than 
the C1 control codes used in ISO8859-1. 
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For Annotations data, ISRA internally retrieves the IS character set and uses the 
equivalent Windows Code Pages for the following ISO encodings: 

ISO Encoding MS Windows counterpart 

ISO8859_1 Cp1252 

ISO8859_2 Cp1250 
ISO8859_5 Cp1251 
ISO8859_6 Cp1256 
ISO8859_7 Cp1253 
ISO8859_8 Cp1255 
ISO8859_9 Cp1254 

ISO8859_13 Cp1257 

Note Specifying an incorrect code page may lead to inconsistency and/or 
corruption of Annotations data. 
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GMTEnabled flag 

This parameter takes two values:  

1. true  

2. false 

The default value of this parameter is false 

Setting “GMTEnabled” to false: When the flag is set to false, it is assumed that 
the ISRA client application is not “GMT Enabled” i.e. client applications will not do 
any timezone conversion. ISRA returns the date committed on the IS to client 
applications after adjusting the difference between the Application Server 
timezone and the GMT Timezone. As a result, the dates displayed in applications 
will be in accordance with the dates committed on the IS. 

Setting “GMTEnabled” to true: When the flag is set to true, it is assumed that 
the client application is “GMT Enabled” i.e. client applications will display the 
dates in GMT. In this case, ISRA returns the date committed on the IS in the 
GMT timezone, without any adjustment. Set this value to true only if you have 
made changes to your application after of an upgrade to ISRA 3.3 FP6 or ISRA 
3.4 FP2. 

ISLocale 

This is a String parameter which represents the ISRA Locale. The administrator 
can set the value of this configurable property as that of the IS locale. It is a 
lower-case two-letter code as defined by ISO-639. The default value of this 
parameter is “en” (English locale). The ResourceBundle used in ISRA will 
depend on the value set by the user for this property. 

 



 

IgnoreObjectBusyMsgInDocMigration  

This is a Boolean parameter which can be set to true to ignore the [77,0,11 The 
object is busy] error, incase of DocMigration. The default value for this parameter 
is false. 

 

Configuring SAP NetWeaver WAS 6.40 Specific Parameters 

The Connector Container Service in the J2EE Engine provides support for 
pooling EIS connections, which can be reused. 

You can configure the connection pooling for each ManagedConnectionFactory 
at deployment time. 

Once the configurable properties are set for ISRA, the Application Server-specific 
parameters, for connection pooling, need to be configured. In case of SAP 
NetWeaver server, the properties that need to be specified are: 

• max-connections-number 
• max-time-to-wait-connections 
• connection-lifetime 
• run-cleanup-thread 

The steps to configure these properties are: 

1. In the SAP NetWeaver Visual Administrator Console, navigate to the 
Connection Definition tab, under Managed Connection Factory tab 
in ISCF. Refer to Configuring Deployed ISRA section for details. The 
following screen appears. 
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2. Select the Expiration check box. The Connection Lifetime, and 

Cleanup Threat fields get enabled. Enter their values, and also in the 
fields: Maximum Connections, and Maximum Time to Wait for 
Connection. Click Save. A confirmation message appears. 

. 

3. Click OK. 

The SAP NetWeaver connection pooling specific parameters gets configured. 

A description of each attribute is given below: 

• max-connections-number – this defines the maximum number of 
connection instances that can be stored in the connection pool 

• max-time-to-wait-connections – using this parameter you can define how 
many seconds the system waits for a connection to be released if there are 
no free connections and the maximum number of pooled connections is 
already achieved. The system throws an exception after this interval. 

• connection-lifetime – use this parameter to define how many seconds a 
connection may stay in pool before it is closed 

• run-cleanup-thread – using this parameter you can schedule a thread that 
periodically cleans up unused connection objects at a regular interval that 
you set in seconds. 
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Configuring Multiple IS Servers with ISRA 

To configure ISRA for accessing multiple IS servers, create a Connection Factory 
for each IS that user wants to connect. 

To create a new connection factory, perform the following steps: 

1. In the SAP NetWeaver Administrative Console, navigate to ISCF. 
Refer to Configuring Deployed ISRA section and follow through till step 
5 for details. The following screen appears. 

 
2. Click on the Clone button. The following dialog box appears. 

 
3. Enter a JNDI name, and click OK. The following confirmation message 

appears. 

 
4. Click OK. The following screen appears. 
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5. A clone of the ISCF connection factory is created. Go to Properties 

tab under Managed Connection Factory tab. Change the values in 
the desired properties and click Add. 

Note Values against the DomainName, and DeploymentInstance must be 
changed. The user may also change the value in OrganizationName. 

6. After changing the values against all the properties, click Save. The 
following confirmation message appears. 

 

7. Click OK. 

A new connection factory is created. 
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3  
Configuring and Deploying ISRA Console 

and Sample Application  

ISRA Console 
The LoadISRA utility from ISRA 3.4.0 has now been replaced with the ISRA 
Console (in ISRA 3.4 fixpack 1 and above). This ISRA console has been 
developed to show the ra.xml properties in a well formatted table and also 
features buttons to enable/disable/edit logging levels dynamically. 

The dynamic update of logging allows the user to enable and change logging 
levels while the ISRA is running and without needing to restart the appserver. 
The console also features links to launch Sample Application and to view JVM 
statistics.  

This console is available as a Web Module (ISRAConsole.war) within 
ISRAConsole.ear and gets deployed automatically during the deployment of 
ISRAConsole.ear 

Configuring Sample Application 
The ISRA console and Sample Application are packaged within a single 
Enterprise Application Archive File (ISRAConsole.ear).  

ISRAConsole.ear consists of: 

• Two Web modules: 

o ISRASampleWEB.war (ISRA Sample Application) 

o ISRAConsole.war (ISRA Console) 

• Deployment Descriptor (application.xml) 

This chapter illustrates the deployment and configuration of the ISRA Console 
and Sample Application on SAP WAS 6.40 Application Server. 

Note ISRA product media comes with an IBM FileNet Image Viewer, which 
can be used to display the TIFF, JPEG, BMP, and other supported file 
formats on a Java-enabled browser. 
 
This Sample Application is intended solely for illustrative purposes and 
it should not be expected to perform useful work, or be used for 
production deployment. This Sample Application is to be used strictly 
as reference material. 

It is assumed that ISRA is deployed and configured for the target IS. 
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In ISRA 3.4 fixpack 1, a new properties file "jndiISRA.properties" has been 
introduced and it gets created in Application Server home directory. The JNDI 
names of connection factories mentioned in this properties file, which will be 
used by Sample application to display on the login page. Two JNDI names 
"ISCF" and "ISCF1" are mentioned in the file by default. Additional library names 
can be included by providing comma separated entries. The property file is 
mandatory and it should contain the same names as the JNDI Binding Paths 
specified for the configured ISRA ConnectionFactories. 

For configuring Sample application, certain properties need to be updated in the 
web.xml of the ISRASampleWEB.war. 

Follow the below steps for extracting web.xml from ISRASampleWEB.war. 

1. Extract ISRASampleWEB.war from ISRAConsole.ear. 
2. Extract web.xml from ISRASampleWEB.war. 
3. Add the following <resource-ref> tag after </welcome-file-list> 

tag in web.xml file for the web application: 
<resource-ref> 

<description>ISRA</description> 

<res-ref-name>ISCF</res-ref-name> 

<res-type>javax.resource.cci.ConnectionFactory</res-
type> 

  <res-auth>Application</res-auth> 

      </resource-ref> 

Note With every new connection factory created, the above <resource-ref> tag 
has to be added, with the appropriate resource reference name. For 
example: when JNDI name of connection factory is ISCF, then <res-ref-
name> is ISCF, and when JNDI name of connection factory is ISCF1, 
then <res-ref-name> is ISCF1. 
 
This is done only in case of configuring multiple instances of IS servers. 
For details on the same, refer to Configuring Multiple IS Servers with 
ISRA section. 

4. Create a file web-j2ee-engine.xml file for the web application with the 
following content, 

<?xml version='1.0' encoding='UTF-8'?> 

<!DOCTYPE web-j2ee-engine SYSTEM 'web-j2ee-engine.dtd'> 

<web-j2ee-engine/> 

5. Add web-j2ee-engine.xml file in the ISRASampleWEB.war file (inside 
/WEB-INF) of ISRAConsole.ear. 

6. To enable extended annotation functionality modify the following 
parameters in web.xml: 
a. Change env-entry-value for "DOCCLASSNAME" to the document 

class configured in the IS for digital signatures. 
<env-entry-value>digDocClass</env-entry-value> 

b. Change env-entry-value for "MAXROWS" to the number of records 
to be fetched from the given document class. 
<env-entry-value>200</env-entry-value> 

7. To enable Remote Printing functionality modify the following 
parameters in web.xml: 
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a. Change env-entry-value for "USEPRINTVIEWOPTION" to either 
Yes or No. This value will determine whether to honor the 
print/view preference set in the web.xml or to take the value 
returned by ViewOne. Default value is No. 

<env-entry-value>No</env-entry-value> 

b. Change env-entry-value for "PRINTVIEWOPTION" to either View 
Only =1, Print Only =2, Print/View =3. This value indicates the 
value of Print/View. The default value is 3. 

<env-entry-value>3</env-entry-value> 

Note If the PRINTVIEWOPTION is set to 3 (default) then the sticky note would 
be saved as a normal sticky note. If PRINTVIEWOPTION value is 
specified as 1 or 2 then the annotations will be saved as an extended 
annotation (Extended annotations are non-standard annotations which 
are saved with a class name parameter (F_CLASSNAME) of 
"Proprietary", a class id property (CLASS_ID) of {A91E5DF2-6B7B-
11D1-B6D7-00609705F027} and a subclass name property 
(F_SUBCLASS) that describes the annotation). 
 
The value of PRINTVIEWOPTION would be honored for each sticky note 
individually, and not for all the sticky notes on a document as a whole. 
 
Thus, the setting for PRINTVIEWOPTION would be processed for either 
a new annotation being added or an existing annotation being modified. 

8. Update web.xml in ISRASampleWEB.war. 
9. Update ISRASampleWEB.war in ISRAConsole.ear. 

After the above configuration, deploy the ISRAConsole.ear into SAP NetWeaver 
WAS 6.40. 

Deploying ISRA Console and Sample Application  
This section describes how to deploy the ISRA Console and Sample Application 
on a SAP WAS 6.40 Server to access ISRA in a managed environment. It is 
assumed that ISRA is deployed and configured for the target IS. 

To deploy the ISRA Console and Sample Application, perform the following 
steps: 

1. Run the DeployTool.bat file from the following location \\usr\<sap 
was instance>\J2E\JC00\j2ee\deploying to start the deploying tool 
of SAP WAS 6.40. The following screen appears. 

April 2009 Image Services Resource Adapter 44 



 

 
2. Click Project > New Project.  

 
3. The following screen appears. 
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4. Select the desired location, and enter the name of the folder to be created in 

the Address field, for example sample_ear. Then click OK.  
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5. Click on the Deployer tab and then click the Connect button. The 
following screen appears. 

 
6. Enter the Password, and click Connect. The following screen 

appears. 

 
7. Click on the Load Ear button. The following screen appears. 
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8. Navigate to the updated ISRAConsole.ear file. Refer to Configuring 

Sample Application section. Then click OK.  
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9. Right-click on ISRAConsole.ear file. In the context menu navigate to 
Deployment > Deploy Ear.  

 
10. Click Yes. 

 
ISRA Console and Sample Application - deployed. The message “Application 
Started Successfully” is displayed in the status bar.

Using the ISRA Console 

To access the ISRA Console, follow the steps below: 

1. Go to the location where the application is available 
(http://<AppServerName>: 
<AppServerPort>/<ApplicationContextRoot>)ApplicationContextRoot is 
ISRAConsole. 
For example : http://9.126.94.39:9088/ISRAConsole/ 



 

 
2. Enter the JNDI name of the library and click Submit.  

A page showing the current values configured in the ra.xml is shown along with 
controls to edit the ISRA logging levels. 

A link has been provided on the page, to access the ISRA Sample Application. 

 
Changes to the logging level settings are applied to ISRA with immediate effect. 
The changes to logging levels are updated in the properties displayed on the 
screen. 
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The changes are valid till the application server is recycled. When the application 
server is restarted the log level settings specified in the ra.xml are used. 

3. The JVM statistics can be used to study the memory usage in the Application 
Server JVM. 

 

Configuring IBM FileNet Image Viewer 
Before deploying FNImageViewer, perform the following steps: 

1. Extract FNImageViewer.war from FNImageViewer.ear. 
2. Extract web.xml from FNImageViewer.war. 
3. Change the file web.xml file for the web application with the following 

content, 
<?xml version="1.0" ?> 

<!DOCTYPE web-app PUBLIC "-//Sun Microsystems, 
Inc.//DTD Web Application 2.3//EN" 
"http://java.sun.com/j2ee/dtds/web-app_2_2.dtd"> 

<web-app id="WebApp_1"> 

 </web-app> 

4. Update web.xml in FNImageViewer.war. 
5. Update FNImageViewer.war in FNImageViewer.ear. 

After the above configuration, deploy the FNImageViewer.ear into SAP 
NetWeaver WAS 6.40. 

Deploying IBM FileNet Image Viewer  
This section describes how to deploy the FNImageViewer on SAP WAS 6.40 
Application Server in a managed environment. IBM FileNet Image Viewer 
application is used by the ISRA Sample Application to display documents of 
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specific mime types (TIFF, JPEG and BMP).It is assumed that ISRA is deployed 
and configured for the target IS.Skip this section, if you do not want the IBM 
FileNet Image Viewer configured with the ISRA Sample application. 

Note Before deploying FNImageViewer.ear on SAP WAS6.40, make an entry 
"ViewOne" in <welcome-file> tag of web.xml file present in 
FNImageViewer.war extracted from FNImageViewer.ear. 

To deploy IBM FileNet Image Viewer, perform the following steps: 

1. Run the DeployTool.bat file from the following location \\usr\<sap 
was instance>\J2E\JC00\j2ee\deploying to start the deploying tool 
of SAP WAS 6.40. The following screen appears. 

 
2. Click Project > New Project.  
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3. The following screen appears. 
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4. Select the desired location, and enter the name of the folder to be created in 
the Address field, for example FNImageViewer. Then click OK.  

 
5. Click on the Deployer tab and then click the Connect button. The 

following screen appears. 

 
6. Enter the Password, and click Connect. The following screen 

appears. 
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7. Click on the Load Ear button. The following screen appears. 
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8. Navigate to the updated FNImageViewer.ear file. Refer to Configuring 
IBM FileNet Image Viewer section. Then click OK.  

 
9. Right-click on FNImageViewer.ear file. In the context menu navigate 

to Deployment > Deploy Ear. 

 
10. Click Yes. 
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FNImageViewer is deployed. The message “Application Started Successfully” is 
displayed in the status bar. 

IBM FileNet Image Viewer Quick Start Feature  
The Quick Start feature provides a mechanism for initializing a Web browser, Java, and 
Image Viewer session. The background task required to initialize an Image Viewer 
session is done at the time when the Web browser is initialized, prior to the time when 
Image Viewer is actually required. This reduces the startup time of Image Viewer. This 
feature is supported on various Operating Systems, such as Microsoft Windows 98, NT, 
2000 Professional, and XP. The only Web browser supported for this feature is Internet 
Explorer. The Quick Start feature is not enabled by default; user needs to manually 
enable it.  

Enabling Quick Start Feature 

To enable quick start feature: 

1. Extract FNImageViewer.ear from the patch.  
2. Check the availability of "quickstart.htm" file in the FNImageViewer.war 

extracted from FNImageViewer.ear  
3. Extract ISRAConsole.ear from the patch.  
4. Extract ISRASampleWEB.war file from ISRAConsole.ear.  
5. Extract 'DisplayDocument.jsp' file from ISRASampleWEB.war.  
6. Add the highlighted tag to the file as shown in the code segment 

below:  

<APPLET CODEBASE = "/FNImageViewer/FNJavaV1Files" ARCHIVE 
="ji.jar"  
CODE = "ji.applet.jiApplet.class" NAME = " viewONE" WIDTH = 
"100%"  
HEIGHT = "97%" HSPACE = 0 VSPACE = 0 ALIGN = middle 
MAYSCRIPT="true">  

-- -- --  

<%if(RAVersion2.equalsIgnoreCase("Enterprise")){%>  

-- -- -- 

<param name="UserId" value="<%=userId%>">  
<param name="quickstartURL" value="quickstart.htm">  
<%}/*End of if condition where 
RAVersion2.equalsIgnoreCase("Enterprise")*/%>  
</Applet> 
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7. Save and close the file.  
8. Bundle the new file into ISRASampleWEB.war  
9. Bundle the WAR file into ISRAConsole.ear.  
10. Undeploy the old ISRAConsole.ear  
11. Deploy the new ISRAConsole.ear.  
12. Open a document in IBM FileNet Image Viewer.  
13. Right-click the document to open the context menu.  
14. From the context menu, click Preferences > QuickStart to enable the 

Quick Start feature. A 'tick' icon appears on the left-hand side of the 
Quick Start menu indicating that the feature is enabled.  

Enabling the Quick Start feature will add an icon within the System tray (bottom 
right of the Windows Desktop) and a menu item “IBM FileNet JavaView 
QuickStart for Internet Explorer” under Start > Programs > Startup menu. After 
enabling Quick Start, if the machine is rebooted, the Quick Start feature remains 
enabled. Disabling the Quick Start feature will remove the Quick Start icon from 
the System tray and the menu item “IBM FileNet JavaView QuickStart for Internet 
Explorer” from the Start > Programs > Startup menu. 

Known Issues in the Quick Start Feature  

Following are the known issues in IBM FileNet Image Viewer: 

• Web session will not end until Quick Start feature is disabled or the user explicitly 
logs out of the session with the Web server. If the Quick Start feature is enabled, 
closing the browser window(s) will not terminate the session with the Web server.  

• If Quick Start is enabled and Internet Explorer is not the default browser, then on 
machine re-login or reboot, a message will display asking whether to make 
Internet Explorer the default browser. To avoid the message:  

1.  Open a browser window.  
2. Select Tools > Internet Options.  
3. Click Programs tab and deselect the check box corresponding to 

"Internet Explorer should check to see whether it is the default 
browser".  

4. Click Apply.  
5. Click OK.  

• If Always button is not selected on the security dialog box of the security 
certificate associated with the Image Viewer, then on machine re-login or reboot, 
a security dialog box is displayed.  

• QuickStart feature is not available in Image Viewer if web server is accessed 
using IP address instead of host name in the URL. 

Testing Sample Application 
After the ISRA Sample Application is started, the steps to verify the deployment 
and access the ISRA Sample Application are: 

1. Open a Web browser and enter the URL 
http://<server:port>/context_root  
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For example: http://9.126.94.39:9088/ISRA/ 

The Web application context_root is case sensitive. On a SAP WAS 6.40 
Server, the default port number is 50000. The default context_root of the 
Sample Application is ISRA. 

 
2. Enter valid Username and Password for the configured IS (check 

configured ConnectionFactory for IS details) and click Logon. 

 
3. Click Help (?) icon, on the Sample Application page, for details on the 

interaction parameters and options. 
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4  
LDAP Configuration 

In addition to direct IS logging, ISRA 3.4.0 also supports LDAP Authentication by 
third party Servers.  

It is necessary to map users present on the LDAP Server to the IS before using 
LDAP Authentication. 

Note The installation of LDAP Server and creation of users on the LDAP 
machine are out of the scope of this document. 

IBM FileNet provides two utilities - ldap_export and ldap_import, to map existing 
users on the LDAP Server to the IS. These utilities are part of the IS package 
and must be executed on the machines running the LDAP Server and the IS. 

The ldap_export utility is used to export usernames on the LDAP Server to an 
xml file. While, the ldap_import utility imports usernames that have been mapped 
to the xml file and creates corresponding users on the IS. 

It is mandatory that the ldap_import algorithm and the xml file be present on the 
same machines, where IS exists. The ldap_import algorithm uses a hashing 
algorithm to generate user passwords for the IS. 

Mapping Existing LDAP Server Users to IS 
To configure user IDs in an IBM FileNet IS library: 

1. Create user entries on the LDAP server. The user attribute “uid” will be 
used to create a user on IS. The remaining attributes (including 
“password”) can be assigned any value. 

2. Use the LDAP_EXP.exe utility to export the user entries created into 
an XML file. 

3. LDAP_EXP program has the following parameters options: 

Option Description 

s <server> LDAP server name or IP address, required value. 

p <port> LDAP port number, optional value, 389 is default. 

d <binddn> LDAP administrator bind domain name (DN), required 
value. 

w <bindpw> LDAP administrator bind password, required value. 

t <ldap server type> Required value for server type: 
msft – Microsoft Active Directory 
sun – Sun One Directory (iPlanet) 
nov – Novell eDirectory(NDS). 
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Option Description 
ibm – IBM Directory. 

b <basedn> LDAP Base DN, optional value. 

g <grouplist filename> Group list file for input, optional value. 

o <XML output filename> XML output filename, optional value. 

l <log filename> Log Filename to use, optional value. 

I Check for special characters on <id> tags only 

E Remove all escape characters – ‘\’. 

k  Use paged results. Windows to AD only. 

Z Use secure socket connection. 

x <grouplist filename> Group list file name for output, optional value. 

v  Verbose log output. 

c1 <user object class> Class type for User, default is 'person'. 

c2 <group object class> Class type for Group, default is 'groupofuniquenames'.  

a1 <user attribute> Attribute to be used for user; default is 'dn'. 

a2 <group attribute> Attribute to be used for group; default is 'dn' 

a3 <member attribute> Attribute to be used for member; default is 
'uniqueMember'  

Note User may use /?, -?, /h or -h to generate help. 

Example command lines: 

• Sun One directory(iPlanet) server:  
ldap_exp -s SunSrvr1 -d "cn=Directory Manager" -w 
":/,.++=" -t sun -b "dc=iPlanet, dc=com"  

• Microsoft Active Directory(AD) server:  
ldap_exp -s Win2KSrvr1 -d 
"CN=Administrator,CN=Users,DC=win2ksrvr1,DC=com" -w 
":/,.++=" -t msft -b "dc=win2ksrvr1,dc=com"  

• Novell eDirectory(NDS) server: 
ldap_exp.exe -s NovSrvr1 -d "cn=Admin, o=server" -w 
":/,.++=" -t nov -b "o=wa" 

• IBM Directory server: 
ldap_exp -s IBMSrvr1 -d "Cn=Administrator" -w ":/,.++=" 
-t ibm 

 -b "dc=ibmsrvr1, dc=com" 

4. Use the LDAP_IMPORT.exe for IS libraries to import the user entries 
from XML file into the specified IBM FileNet IS library. 

Parameters: 



 

/?  Help screen 

/h<host>[:organization]  IS host or domain name, organization. 

/u<id> (used with /p)  Authorized IS user name 

/p"<pwd>" (used with /u)  Encrypted IS user password. 

/i<file>  XML input file 

For example, to import user entries from XML file:  
C:\>ldap_import /hIMGSERV:FileNet /ildap_exp.xml 

Note Options are not case sensitive. All the information or error messages are 
logged to the system log or the file 'ldap_importyyyymmddlog.txt'. If 
Username and password are not specified in the command, it prompts 
for username and password. 

5. The IBM FileNet users created will have a password generated from 
the corresponding user IDs. 

Changing ISRA Specific Parameters for LDAP 
The configurable properties to be set (modified) in ra.xml are: 

• LdapImplClassName 
• LdapImplClassString 
• InherentLogin 

Refer to LdapImplClassName, LdapImplClassString, and InherentLogin, in 
section Configurable ra.xml Properties for details on the configuration of the 
respective entities. 
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5  
Undeployment 

This section describes the undeployment procedure to remove ISRA and the 
Sample Application from the SAP WAS 6.40 Server. 

Undeploying ISRA  
To undeploy ISRA using the Visual Administrator, perform the following steps: 

1. In the SAP NetWeaver Administrative Console, navigate to Services. 
Refer to Configuring Deployed ISRA section for details. Click Deploy. 
The following screen appears. 

 
2. Under Deployed Components, navigate to Deploy Service > Server 

0 <id> > connector > sap.com/isra_34sap. The following screen 
appears. 

 

Note The id of Server 0 depends on the patch level version of J2EE Engine 
used in SAP NetWeaver WAS 6.40.  
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3. Click Remove. The following screen appears. 

 
4. Click OK to undeploy ISRA.  

ISRA gets undeployed. 
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Undeploying ISRA Console and Sample Application  
To undeploy ISRASample using Visual Administrator, perform the following 
steps: 

1. In the SAP NetWeaver Administrative Console, navigate to Services. 
Refer to Configuring Deployed ISRA section for details. Click Deploy. 
The following screen appears. 

 
2. Under Deployed Components, navigate to Deploy Service > Server 

0 <id> > servlet_jsp > sap.com/ISRA Console. The following screen 
appears. 

Note The id of Server 0 depends on the patch level version of J2EE Engine 
used in SAP NetWeaver WAS 6.40.  

April 2009 Image Services Resource Adapter 65 



 

 
3. Then click Remove. The following screen appears. 

 
4. Click OK to undeploy ISRA Console and Sample Application. 

ISRA Sample gets undeployed. Similarly, FNImageViewer can also be 
undeployed. 
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6  
Troubleshooting 

This section describes how to troubleshoot ISRA. 

Disabling NCH Broadcasts 
ISRA users (application client) need to access IS libraries across routers on networks where 
broadcasts are disabled. This is done by creating alias entries for the IS libraries in the hosts file, 
where ISRA is deployed. ISRA must locate the IP address of the NCH server to find other IS 
services for an IS setup. 

ISRA attempts to find the NCH server by generating broadcast packets, even if the NCH server 
was not reachable using broadcasts. User can disable NCH server location broadcasts to reduce 
broadcast traffic on the network. 

User may want to disable NCH broadcasts if: 

• Routers are present between servers, 
• Want no broadcast activity on the networks, 
• Want to force a multi-homed server to use a specific IP address configured by the 

operating system network directory search facility. 

To specify the alias in the hosts file: 

1. Locate hosts file on the server. It is located in the /etc folder on UNIX/Linux 
systems. On a Microsoft Windows Server, it is located in the 
\system32\drivers\etc under the Windows installation directory. 

2. Open the hosts file with a preferred text editor. If a host file does not exist, create a 
new file using the preferred text editor. 

3. For each IBM FileNet library that user needs to connect through ISRA, entries should 
be made in the hosts file as <IP address of domain:organization> 
<domain-organization>-nch-server, where: 
• <IP address of domain:organization> is IP address of an IBM FileNet 

domain and organization identifying the target IBM FileNet library system (NCH 
Server). 

• <domain-organization> is domain and organization name. The rules to 
follow while specifying the domain-organization name are: 
 Delete all characters except ASCII alphanumeric characters and 

hyphens. 
 Convert all upper case characters to lower case. 
 Insert a hyphen between the domain and organization names. 
 Append nch-server as a literal. 

For example, if an IBM FileNet library has a domain, fn_is, and organization IBM, and its 
IP address is 123.45.6.78, the hosts file entry will be 123.45.6.78 fnis-IBM-nch-
server 
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Appendix A: ra.xml 

ra.xml 
<?xml version="1.0" encoding="UTF-8"?> 
 
<!DOCTYPE connector PUBLIC '-//Sun Microsystems, Inc.//DTD Connector 
1.0//EN' 'http://java.sun.com/dtd/connector_1_0.dtd'> 
 
<connector> 
  <display-name>ISRA</display-name> 
  <vendor-name>IBM</vendor-name> 
  <spec-version>1.0</spec-version> 
  <eis-type>IBM FileNet Image Services</eis-type> 
  <version>3.4.0</version> 
  <license> 
    <license-required>false</license-required> 
  </license> 
  <resourceadapter> 
    <managedconnectionfactory-
class>com.filenet.is.ra.spi.FN_IS_SpiManagedConnectionFactory</managedc
onnectionfactory-class> 
    <connectionfactory-
interface>javax.resource.cci.ConnectionFactory</connectionfactory-
interface> 
    <connectionfactory-impl-
class>com.filenet.is.ra.cci.FN_IS_CciConnectionFactory</connectionfacto
ry-impl-class> 
    <connection-interface>javax.resource.cci.Connection</connection-
interface> 
    <connection-impl-
class>com.filenet.is.ra.cci.FN_IS_CciConnection</connection-impl-class> 
    <transaction-support>NoTransaction</transaction-support> 
    <config-property> 
      <description>Domain name of the Image Services 
Server</description> 
      <config-property-name>DomainName</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
      <config-property-value>FileNetIS</config-property-value> 
    </config-property> 
    <config-property> 
      <description>Organization name of the Image Services 
Server</description> 
      <config-property-name>OrganizationName</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
      <config-property-value>IBM</config-property-value> 
    </config-property> 
    <config-property> 
      <description>0-Exceptions and Warnings; 1-Info; 2-Debug 
Level</description> 
      <config-property-name>LoggingLevel</config-property-name> 
      <config-property-type>java.lang.Integer</config-property-type> 
      <config-property-value>0</config-property-value> 
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    </config-property> 
    <config-property> 
      <description>0-No Logging; 1-Console Logging; 2-File Logging; 3-
Both(File and console)</description> 
      <config-property-name>LoggingMode</config-property-name> 
      <config-property-type>java.lang.Integer</config-property-type> 
      <config-property-value>3</config-property-value> 
    </config-property> 
    <config-property> 
      <description>Page data fetch size (in kilo bytes)</description> 
      <config-property-name>PageBufferSize</config-property-name> 
      <config-property-type>java.lang.Integer</config-property-type> 
      <config-property-value>64</config-property-value> 
    </config-property> 
    <config-property> 
      <description>Cache refresh interval(in minutes)</description> 
      <config-property-name>CacheRefreshInterval</config-property-name> 
      <config-property-type>java.lang.Integer</config-property-type> 
      <config-property-value>30</config-property-value> 
    </config-property> 
 
   
    <config-property> 
      <description>Security cache mode(1-caches users and groups  2- 
caches groups only)</description> 
      <config-property-name>SecurityCacheMode</config-property-name> 
      <config-property-type>java.lang.Integer</config-property-type> 
      <config-property-value>1</config-property-value> 
    </config-property> 
 
    <config-property> 
      <description>Selective metadata refresh(1-printer cache 2-doc 
class cache 4-key fields cache 8-menu values cache )</description> 
      <config-property-name>MetaDataCacheRefreshMode</config-property-
name> 
      <config-property-type>java.lang.Integer</config-property-type> 
      <config-property-value>15</config-property-value> 
    </config-property> 
 
    <config-property> 
      <description>Name of the Product</description> 
      <config-property-name>ProductName</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
      <config-property-value>IBM FileNet Image Services Resource 
Adapter</config-property-value> 
    </config-property> 
    <config-property> 
      <description>Product Version</description> 
      <config-property-name>ProductVersion</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
      <config-property-value>ISRA 3.4.0 Enterprise</config-property-
value> 
    </config-property> 
    <config-property> 
      <description>ISRA Logfile name (can include path) </description> 
      <config-property-name>LogFileName</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
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      <config-property-value>ISRA.log</config-property-value> 
    </config-property> 
    <config-property> 
       <description>Maximum Size of ISRA LogFile (in mega 
bytes)</description> 
   <config-property-name>LogFileSize</config-property-name> 
   <config-property-type>java.lang.Integer</config-property-type> 
   <config-property-value>5</config-property-value> 
    </config-property> 
 <config-property> 
               <description>LDAP Authentication Class 
Name</description> 
           <config-property-name>LdapImplClassName</config-property-
name> 
           <config-property-type>java.lang.String</config-property-
type> 
           <config-property-
value>com.filenet.is.ra.fnis.FN_IS_IPlanetImpl</config-property-value> 
    </config-property> 
    <config-property> 
               <description>Server details for LDAP Authentication 
</description> 
           <config-property-name>LdapImplClassString</config-property-
name> 
           <config-property-type>java.lang.String</config-property-
type> 
           <config-property-
value>filenetserver;389;ou=Users,ou=FileNet,dc=FilenetRoot</config-
property-value> 
    </config-property> 
    <config-property> 
               <description>Inherently login through LDAP 
authentication or not 0-Direct IS Login;1-LDAP 
Authentication</description> 
    <config-property-name>InherentLogin</config-property-name> 
    <config-property-type>java.lang.Integer</config-property-type> 
    <config-property-value>0</config-property-value> 
    </config-property> 
    <config-property> 
       <description>ISRA instance that is currently being deployed on a 
single machine; Min Value = 1, Max Value = 10</description> 
   <config-property-name>DeploymentInstance</config-property-name> 
   <config-property-type>java.lang.Integer</config-property-type> 
   <config-property-value>1</config-property-value> 
    </config-property> 
   <config-property> 
      <description>Parameter to enable PCH Logging in ISRA 
</description>  
      <config-property-name>PCHLogging</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
      <config-property-value>Disabled</config-property-value> 
   </config-property> 
   <config-property> 
         <description>LDAP Anonymous user login flag</description>    
         <config-property-name>AllowAnonymousUser</config-property-
name> 
         <config-property-type>java.lang.Boolean</config-property-type> 
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         <config-property-value>true</config-property-value> 
 </config-property> 
 <config-property> 
      <description>0-No Logging; 1-File Logging</description> 
      <config-property-name>RPCLogging</config-property-name> 
      <config-property-type>java.lang.Integer</config-property-type> 
      <config-property-value>0</config-property-value> 
    </config-property> 
 <config-property> 
      <description>Codepage for ISRA</description> 
      <config-property-name>ClientCodepage</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
      <config-property-value>cp1250</config-property-value> 
 </config-property> 
 <config-property> 
      <description>Locale of the Image Services Server (two letter ISO 
language code, for example en, de, ar, ja)</description> 
      <config-property-name>ISLocale</config-property-name> 
      <config-property-type>java.lang.String</config-property-type> 
      <config-property-value>en</config-property-value> 
  </config-property> 
  <config-property> 
   <description>It is a configurable parameter to Ignore [77,0,11 The 
object is busy] error, incase of DocMigration</description> 
   <config-property-name>IgnoreObjectBusyMsgInDocMigration</config-
property-name> 
   <config-property-type>java.lang.Boolean</config-property-type> 
   <config-property-value>false</config-property-value> 
 </config-property> 
    <authentication-mechanism> 
      <authentication-mechanism-type>BasicPassword</authentication-
mechanism-type> 
      <credential-
interface>javax.resource.security.PasswordCredential</credential-
interface> 
    </authentication-mechanism> 
    <reauthentication-support>false</reauthentication-support> 
  </resourceadapter> 
</connector>
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Notices 

Notices 
This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, or 
service is not intended to state or imply that only that IBM product, program, or service may 
be used. Any functionally equivalent product, program, or service that does not infringe any 
IBM intellectual property right may be used instead. However, it is the user's responsibility 
to evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in 
this document. The furnishing of this document does not grant you any license to these 
patents. You can send license inquiries, in writing, to:  

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY  10504-1785 

U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual 
Property Department in your country or send inquiries, in writing, to:  

IBM World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS 
MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not 
allow disclaimer of express or implied warranties in certain transactions, therefore, this 
statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new 
editions of the publication. IBM may make improvements and/or changes in the product(s) 
and/or the program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only 
and do not in any manner serve as an endorsement of those Web sites. The materials at 
those Web sites are not part of the materials for this IBM product and use of those Web 
sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you. 



 

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs and 
other programs (including this one) and (ii) the mutual use of the information which has 
been exchanged, should contact:  

IBM Corporation 

J46A/G4 

555 Bailey Avenue 

San Jose, CA  95141-1003 

U.S.A. 

Such information may be available, subject to appropriate terms and conditions, including 
in some cases, payment of a fee. 

The licensed program described in this document and all licensed material available for it 
are provided by IBM under terms of the IBM Customer Agreement, IBM International 
Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary significantly. 
Some measurements may have been made on development-level systems and there is no 
guarantee that these measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through extrapolation. Actual 
results may vary. Users of this document should verify the applicable data for their specific 
environment. 

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has not 
tested those products and cannot confirm the accuracy of performance, compatibility or any 
other claims related to non-IBM products. Questions on the capabilities of non-IBM 
products should be addressed to the suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. 
To illustrate them as completely as possible, the examples include the names of 
individuals, companies, brands, and products. All of these names are fictitious and any 
similarity to the names and addresses used by an actual business enterprise is entirely 
coincidental. 

COPYRIGHT LICENSE: 

This information contains sample application programs in source language, which illustrate 
programming techniques on various operating platforms. You may copy, modify, and 
distribute these sample programs in any form without payment to IBM, for the purposes of 
developing, using, marketing or distributing application programs conforming to the 
application programming interface for the operating platform for which the sample programs 
are written. These examples have not been thoroughly tested under all conditions. IBM, 
therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.  

Trademarks 

• IBM is a registered trademark of International Business Machines Corporation in the 
United States, other countries, or both.  
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• Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or 
other countries.  

• Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the 
United States, other countries, or both and is used under license there from.  

• Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the 
United States, other countries, or both.  

• Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft 
Corporation in the United States, other countries, or both.  

• Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, 
Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered 
trademarks of Intel Corporation or its subsidiaries in the United States and other 
countries.  

• UNIX is a registered trademark of The Open Group in the United States and other 
countries.  

• Linux is a registered trademark of Linus Torvalds in the United States, other countries, or 
both.  

• ITIL is a registered trademark, and a registered community trademark of the Office of 
Government Commerce, and is registered in the U.S. Patent and Trademark Office. 

• IT Infrastructure Library is a registered trademark of the Central Computer and 
Telecommunications Agency, which is now part of the Office of Government Commerce. 

• Other company, product, or service names may be trademarks or service marks of 
others.
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